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Essentials about the International Callbook on CD ROM

The Radio Amateur Callbook on CD-ROM (Callbook) lets you find the data you are looking for in a fast 

and easy manner.

The Callbook is divided in two databases: The U.S. and the international database.    This is because the 

U.S. contains much more information than the international, ie, license data, time zone and area code.

In the U.S. database, you can search by different fields (call, name, city, ZIP or county).    In addition, 

there is a text search facility. Use the Search menu to start the search.

In the international database, you can search by call sign or by text string.



The menu bar

The menu bar contains the following menus:

File: Commands to switch the active database between the international and the U.S. portion of the 

callbook, to print an entry and to end the program.

Edit:    Commands to copy the displayed data to the clipboard and for starting the CW-Output.

Search: Commands to search by fields (call, name, city, ZIP or county) and text search.

View: Commands to switch to the different windows of the program. The commands to view the text files 

included in with the Radio Amateur Callbook on CD-ROM are also located here.

Report Commands to print labels from the report file.

Tools: Commands to start tools like the Beacon Scheduler and the Locator Tool Box.

Options Commands to set various program options.

Help: Commands to start the online help and displaying the "about" dialog.



Menu Search

This menu contains the commands to search by fields:

Call

Name

City

ZIP

County

Note that the commands Name, City, ZIP and County are disabled (grayed out) if the international 

database is selected.

The command to start the text search is also found in this menu:

Text search

The command QSL manager opens the QSL managers list.



Search functions

Basically, there are two ways to find entries into database:

· Moving back and forward by using the "+1", "-1", "+10", "-10" etc. buttons

· Using the search commands



Whats new in the 2003 Edition of the Radio Amateur Callbook
New features of the 2003 edition of the RAC on CD-ROM

· Fully updated databases

· Now 768,285 entries in the international and 761,995 entries in the US database

· New amateurs:21,854

· More than 96,995 changes

· Direct link for sending E-Mails



Menu Edit
This menu contains the command to allow you to copy the displayed data into the windows clipboard. 

The second command opens the notes window, which allows you to edit notes.

There are a shortcuts for both commands: Ctrl+C for Copy and Ctrl+N for Notes.



Edit|Copy command

Copy copies the text of the displayed database entry to the windows clipboard.    The clipboard allows you

to process the data you found in the Radio Amateur Callbook on CD-ROM by other windows applications,

ie, a word processor or a label printing program. The text structure is determined by the Clipboard 

settings located in the Program options dialog. The structure for "All available information" is shown 

below:

For the U.S. database:
Call
State
ZIP
License class
License issue date
License expiration date
Longitude
Latitude
Area code
County
Timezone
QTH
Day of birth
DXCC country
Postal country

For the international database:
Call
License class
QTH
DXCC country
Postal country

You are allowed to use the copy command up to 10 times a minute. After using the copy command more 

than 10 times a minute, a dialog box will remind you of this limitation. The box can be closed by using the 

"OK" button.

There is a shortcut for Copy: Ctrl+C.



Edit|Morsecode output command
Starts the morsecode output. 

There is a shortcut for the morsecode output command: F9.

To abort the morsecode output, press the Esc key. The morsecode output will stop after finishing the 

current character.



How to find...

The callbook offers multiple ways to find an entry you are looking for:

Search by Call

Search by last name

Search by name of city

Search by name of county

Search by ZIP

Text search

Choose one of the above for an example describing the step-by-step process in using the search 

functions.



Copyright, license agreement

Copyright and license agreement

The Radio Amateur Callbook CD-ROM (program and data) is copyright 2002 by Radio Amateur Callbook, 

575 Prospect Street, Lakewood, NJ 08701. All rights reserved. No part of this data may be reprinted, or 

reproduced, or utilized in any form or by any electronical, mechanical, or other means, now known or 

hereafter invented, including photocopying and recording, or in any information storage and retrieval 

system, without permission in writing from the Publisher.

Limited Warranty 

This software is protected by international copyright laws. Under this copyright law, you are prohibited 

from duplicating the software for any purpose other than making archival copies for the sole purpose of 

backing up against loss.

We specifically disclaim all warranties either expressed or implied, including but not limited to implied 

warranties of merchantability and fitness for a particular purpose, with respect to the software and the 

accompanying hardware.

In no event shall Radio Amateur Callbook be liable for any consequential or incidental damages, including

any loss of business profits or any other commercial damages arising out of the use of its product.



The morsecode output

The morsecode output can be started by the Edit|Morsecode output command.

When started, the window "CW output" opens and displays the text to be morsed. The currently morsed 

character is highlighted and the mouse pointer changes its shape just over the text area of this window. 

you can use the ESC key or a click on the "Stop" button to stop the morse code output.

The format of the text output of the morsecode program is like the format used by the copy command:

For the U.S. database:
Call
State
ZIP
License class
License issue date
License expiration date
Longitude
Latitude
Area code
County
Timezone
QTH
DXCC country
Postal country

For the international database:
Call
License class
QTH
DXCC country
Postal country

There can only be one morsecode output of an entry at a time. You will be advised of this, if you try to 

start the morsecode output when the current morsecode output is still active.

There is a shortcut for the morsecode output command: F9.

To abort the morsecode output, press the Esc key. The morsecode output will stop after finishing the 

current character.

After the morsecode output has finished (or has been aborted), the mouse pointer changes to its normal 



shape with the next move of the mouse.

Thanks to DL3ECD, Ulrich Mester, for the original (stand alone) version of the morsecode output. Idea 

and graphics of the morse bug of the morsecode output by DL3ECD, Ulrich Mester.



Using the search commands

By using the seach commands, you can enter a text you are looking for and let the program make a 

search through the database.

You can use the commands to search by call, name, city, county or ZIP: This means the search is limited 

to the selected search criteria. Using text search means to search for entries containing    words    you 

select.

Examples:

· If you know the call of someone, use the Search|Call command to find him.

· If you know soneones last name, use the Search|Name command. Perhaps there is more than a 

single entry with the name you are looking for. In this case use the "+1" to proceed to the wanted entry.

· If the only things you know are his first name and the street he lives in, use the Search|Text search 

command. 

See also:

How to find...?



Moving back and forward

Using the "+1", "-1", "+10" etc. buttons and the "Sort by" radiobuttons, the program displays previous or 

next entries. The sort order is determined by the "Sort by" radiobuttons: If "Sort by call" is checked, 

clicking on the "+1" button shows the next call. Clicking on the "-1" buttons shows the call coming before 

the current entry.

Example:

Imagine the following part of the callbook (U.S. database):

AA1AA

AA1AB

AA1AC

The current entry should be AA1AB, If "Sort by call" is checked, clicking on the "+1" button will display 

AA1AC, clicking on the "-1" button will display AA1AA.

The "-10" button tries to display the entry 10 entries before the current entry, the "+10" button tries to 

display the entry 10 entries after the curent entry, and so for the other buttons.



Example: Search by call

Note: 

- Use the international database. (Use Ctrl+I to select.)

- Ensure that no menu is selected.

Example: Who is DB3ZX?

Step 1: Press Alt+C to activate then "Call" edit field. The cursor is ready for your input, blinking in the 

"Call" edit. Perhaps the text of the last search is displayed in call edit. Because the text is inverse, it

will disappear with the first character you type in.

Step 2: Now type in the wanted call sign: DB3ZX. Do not use any blanks.

Now, the call edit should show DB3ZX only.

Step 3: Finish the text input by pressing Enter.

After a short delay, the program shows the requested entry. If the requested call could not be found, a 

window will inform you.



Example: Search by name

Notes: 

· Use the U.S. database. (Use Ctrl+U to select.)

· Ensure that no menu is selected.

· You can also use the text search dialog to search by name.

Example: Searching for the name "miller"

Step 1: Choose the command Name in the menu Search. You can do this by opening the Search menu 

and clicking the Name command with the mouse. Pressing Alt+S and N or    pressing F3 only will lead to 

the same result.

The "Search by name" dialog appears. The cursor is ready for your input, blinking in the "Name" edit. 

Perhaps the text of the last search is displayed in call edit. Because the text is inverse, it will disappear 

with the first character you type in.

Step 2: Now type in the wanted name: miller. Do not use any blanks.

Now, the name edit should show miller only.

Step 3: Finish the text input by pressing Enter or clicking on the "Ok" button.

After a short delay, the program shows the first entry containing the name "miller" (AA1CY). If the 

requested name could not be found, a window will inform you.

Note: There are many more entries with the name "miller". The "+1", "+10", etc. buttons allow to navigate 

through the entries by name, if sort by name is activated. This has been done by the program after the 

search.



Example: Search by city

Note: 

· Use the U.S. database. (Use Ctrl+U to select.)

· Ensure that no menu is selected.

· You can also use the text search dialog to search by city.

Example: Searching for the city "ruckersville"

Step 1: Choose the command City in the menu Search. You can do this by opening the Search menu 

and clicking the City command with the mouse. Pressing Alt+S and I or    pressing F4 only will lead to the 

same result.

The "Search by city" dialog appears. The cursor is ready for your input, blinking in the "City" edit. Perhaps

the text of the last search is displayed in call edit. Because the text is inverse, it will disappear with the 

first character you type in.

Step 2: Now type in the wanted city: ruckersville. Do not use any blanks.

Now, the city edit should show ruckersville only.

Step 3: Finish the text input by pressing Enter or clicking on the "Ok" button.

After a short delay, the program shows the first entry containing the city "ruckersville" (K4EBL). If the 

requested city could not be found, a window will inform you.

Note: There are many more entries with the city "ruckersville". The "+1", "+10", etc. buttons allow to 

navigate through the entries by city, if sort by city is activated. This has been done by the program after 

the search.



A QSL manager is a station handling the receiving and sending of QSL cards for another station.



Search|Call command

Starts the search for the call you have entered in the "Call" field.

The program will automatically search in both databases and switch to the database in which the call sign
has been found.

If the requested call sign could not be found, the program displays a "Call could not be found" message. 
The program remains in the current database and tries to find a call closest to the requested call.

The last 50 calls you have entered will be added to the redo list. Click on the down arrow to the right of 
the edit field to display this list. Selecting a call out of the list will copy it to the edit field. Now you can 
correct the call if it was misspelled or repeat the search, by pressing Enter.



Search|Name command

This command starts the Search by name dialog.

Note: This command is deactivated during the use of the international database. To choose the U.S. 

database, use the File|U.S. database command.



Search|City command

This command starts the Search by city dialog.

Note: This command is deactivated during the use of the international database. To choose the U.S. 

database, use the File|U.S. database command.



Help|Content command

Starts the online help for the Radio Amateur Callbook on CD-ROM. The first page displayed will be the 

contents of the online help.

The shortcut for the Content command is F1.



Help|About command

Shows a dialog box that informs you about the edition and the copyright for the Radio Amateur Callbook 

on CD-ROM. Use the "Ok" button to close the dialog.



File|Exit command

Ends the Radio Amateur Callbook on CD-ROM.

As usual, the shortcut for the Exit command is Alt+F4.



Help menu

This menu contains the commands to open the help file and to show the information about the program:

You can open the help file by three methods:
· Content. lets the windows help system open the help file.

· "Open the help file as RTF" opens a file in Rich Text Format (RTF) with the contents of the help file.

· "Open the help file as text" opens an ANSI text file with the contents of the help file.

About.shows you the copyright information of the program.



System requirements

Microsoft™ Windows™ 

The Radio Amateur Callbook on CD-ROM requires at least Microsoft Windows 95. It has also been tested

under a Windows 98, ME, NT 4.0, 2000 and Windows XP environment.

Video

The Radio Amateur Callbook on CD-ROM requires at least a VGA adapter running a resolution of 

640x480 pixels. Lower resolutions will lead to a loss of image information. However, to see the map 

display without scrollbars, a resolution of 800x600 pixels is required.

CD-ROM drive

The Radio Amateur Callbook on CD-ROM accesses the CD-ROM via operation system only. Your CD-

ROM drive must be configured like a standard DOS drive. A unique drive identification letter is required 

(i.E. "E:").

Memory and ressources

The Radio Amateur Callbook on CD-ROM requires about 4 MB memory. Using the text search, map 

display, notes edit,    windows help or other extra windows will increase this requirements.



Search by name dialog

To search an entry by last name, simply type in the name you are looking for and press the Enter key (or 

click the Ok button).

To abort, press ESC or click the Cancel button.

The program displays an entry with a last name similar to the name you typed in, if the requested name 

could not be found.

Notes: 

· This option searches inside the U.S. database only. If you are looking for a name in the international 

database; change to the international database and use text search.

· You can also use the text search dialog to search by name



Search by city dialog

To search an entry by city, simply type in the city you are looking for and press the Enter key (or click the 

Ok button).

To abort press ESC or click the Cancel button.

The program displays an entry with a city similar to the city you typed in, if the requested city could not be 

found.

Notes: 

· This option searches inside the U.S. database only.    If you are looking for a city in the international 

database; change to the international database and use text search. 

· You can also use the text search dialog to search by city.



Menu View

In this menu, you find the commands to activate the different windows of the program:

Details shows you three extra fields, if available for the current entry: Fax number, e-mail address and 

comments given by this amateur. Shortcut for this command is Ctrl+D. The button "Details" is grayed out, 

if no extra information is available for this entry.

List opens the list window. Shortcut for this command is Ctrl+L.

Map activates the map window and shows the map of the location of the current entry there. Shortcut for

this command is Ctrl+M.

DXCC Information shows you details about the DXCC country of the current entry.

US County and State Information shows you details about state and the county of an entry out of the 

U.S. database.

The main window is the window active after the start of the program (where a call can be entered). Use 

the View|Main Window command in the menu or the shortcut Ctrl+W to activate. Using the shortcut is 

very useful if another window of the programs hides the main window.

This menu contains also the commands to view one of the many text files included with the Radio 

Amateur Callbook on CD-ROM. Some of the text files are combined in an extra submenu, such as the 

submenu Prefixes.

Note:    Viewing text files will start the windows editor (Notepad.exe) which will display the text file.    Use 

the notepad help or your windows documentation if you are not familiar with windows notepad editor.



How to print labels (ASCII method)
This topic describes the handling using the ASCII method. 

Note: Printing labels with the ASCII method is available only if the ASCII method is selected.

Features of the ASCII method:

· Uses any ASCII compatible printer, even without installing a window printer driver (e.g. when there is 

no printer driver available)

· Supports only 1-across labels

· Can be used to create a CSV export file

Make sure that your printer is connected directly to the computer. Any use of spoolers or network systems

may cause serious problems during printing of labels.

Printing a label is easy: Choose "Print label" in the "File" menu to print the current entry to a label.

Line printers like dot matrix printers will print the label immediately.

Page oriented printers like laser printers will print complete pages only. To eject a page with fewer labels 
on it, use the "Send form feed" command in the "File" menu.

With the default settings, the program prints to "PRN", which is usually "LPT1" on your system. To change
this settings, use the Label printing options (General) dialog (page "Labels"). It can be opened with the 
"Program..." command in the "Options" menu.

If you have problems with the print label feature, refer to the file "PRINT.TXT" on the CD-ROM.



Menu File

This menu contains commands to choose the active database, to print labels and the Exit command to 

end the program:

U.S. database

International database 

Print label

Send form feed

Mark label for printing

Start printing labels

Exit 



Search|ZIP command

Starts the search for the ZIP you have entered in the "ZIP" field.

Note that this function is enabled in the US database only.

If the requested ZIP could not be found, the program displays a "ZIP could not be found" message. The 
program then tries to find a ZIP closest to the requested ZIP.

The last 50 ZIPs you have entered will be added to the redo list. Click on the down arrow right to the edit 
field to display this list. Selecting a ZIP out of the list will copy it to the edit field. Now you can correct the 
ZIP if it was entered incorrectly or repeat the search by pressing Enter.

Notes: 

· This command is deactivated during the use of the international database.    To choose the U.S. 

database, use the File|U.S. database command.

· You can also use the text search dialog to search by ZIP.



Search|County command

Starts the search for the County you have entered in the "County" field.

Note that this function is enabled in the US database only.

If the requested County could not be found, the program displays a "County could not be found" 
message. The program then tries to find a county closest to the requested county.

The last 50 counties you have entered will be added to the redo list. Click on the down arrow right to the 
edit field to display this list. Selecting a county out of the list will copy it to the edit field. Now you can 
correct the county if it was misspelled or repeat the search by pressing Enter.

Notes:

· This command is deactivated during the use of the international database. To choose the U.S. 

database, use the File|U.S. database command.

· You can also use the text search dialog to search by county.



Text search dialog

This is how the Text search dialog looks:

The text search dialog consists of 5 important elements:
1. The editline (word edit) where you can type in the words you are looking for.

2. The word list: Displays the words stored in the database.

3. The Add, Remove and Clear buttons in between the word and the search list.

4. The search list: Displays the words you have chosen to search for.

5. The button line at the bottom of the dialog, to start the search, cancel the search or display this help 

screen.

General: The program will search in the active database for all entries containing the words in the search 

list. If the search list is empty, the number of entries found will be zero.    If no entries are found for the 

words in the search list, the number of entries found will also be zero.

How to add words to the search list: There are multiple ways to select words:
· Type in the word you are looking for (click on the word edit or press Alt+W to activate the word edit, if 

not active). The word list shows a number of words beginning with the letters you typed in.

· You can use the up and down keys to navigate through the words in the word list.

· You can combine both methods by; typing in the first letters then using the up and down keys to select

the word from the word list.



If a word is highlighted in the word list, click the Add button or press Alt+A. The highlighted word will be 

copied into the search list.    The number in brackets (13920) following the word shows the number of 

entries containing this word.    Each word can be in the search list only once. Using the Add button once 

again has no effect.

It is also possible to choose a word from the word list by double clicking on the word.

Starting the search:

Click the "OK" button or press Enter to close the dialog and to show all entries containing the words in the

search list. Depending on the number of entries, there can be a short delay. A progress indicator informs 

you about the progress of search.    If there are more than 100 entries to search for, click on the progress 

indicators "Abort" button and this will cancel the search. In this case, the number of entries found will be 

zero.

Viewing the entries found:

After finishing the search, the program closes the dialog and informs you of the number of entries found. If

the number is not zero, the Sort by "Search results" radio button is checked.    That means, that you can 

navigate through the entries found. The entries found are sorted by call sign. 

The program shows in the gap between the "+1" and the "-1"button the number of entries found (3139) 

and the position of the current entry (1).:

How to remove words from the search list:
· The Remove button will remove the indicated word in the search list.

· The Clear button will remove all words from the search list (clears the search list completely).

· Double clicking a word in the search list will remove it from the search list.

Note that the Remove and Clear button are deactivated if the search list is empty.

Hints:
· The fastest way to select words and copy them to the search list is to use the keyboard short cuts 



(Alt+A, Alt+R, Alt+C) for the Add, Remove and Clear buttons instead of clicking on them.

· Words with a large number of entries will slow down the search.

· To prevent having to review a large number of entries, use additional words to narrow down the 

search. For example, if you select the word "Miller" in the U.S. database, approximately 4,000 entries 

will be found.

· Use the extended text search features to reduce the number of entries found: There are 30215 entries

with the word "john", but only 96 with the word "lastname=john". Extended word search is availabe for 

names ("lastname=miller", firstname="thomas"), ZIP ("zip=22968"), city ("city=boston"), county 

("county=orange"), state ("state=ny") and previous call ("prevcall=a2jaq"). 

· If you search for things like "Los Angeles", you have to search for the two words "los" and "angeles", 

because there are no blanks allowed in the words you search for. Every word is a single entry in the 

search list. This is also true for the extended word search: A search for the city of Los Angeles 

consists out of "city=los" and "city=angeles" in the search list.

Limitations:

The search list does not accept more than 13 words.    The Add button is deactivated if this limitation is 

reached.



Search|Text search command

This command starts the Text search dialog.



Sort order

Depending on the "Sort By" radiobuttons, the entries are sorted in a specific manner. This is important for 

the "+1", "-1", "+10" etc. buttons, as they display the next/previous etc. entry.

There is a major and a minor sort order:

The major sort order is selected by the "Sort By" radiobuttons: If "Call" is selected, the next entry would 

be the entry with a call following to the displayed entry’s call. Calls are unique, so there is one call for 

each entry and vice versa. Names, cities, counties or ZIPs are not unique: There can be more than one 

entry with the same name, city, county or ZIP.

This is when the minor sort order comes in: If there are entrys with the same name (or city, county, ZIP), 

this entries are sorted by calls.

Example: 
1. Search for the name "miller" in the U.S. database. The program will display the entry with the 

lastname "miller" and the (alphabtical) lowest call of all "miller"s in the U.S. database.

2. Now click on the "-1" button. The program will display the entry that in alphabetical order is ranked 

ahead of "miller".

3. Click on the "+1" button. The first miller will be displayed again.

4. Click on the "+1" button again: The program will display the miller with the next call sign.



Active database

The database in use at the moment (the U.S. or the international). The active database is checked in the 

File menu and in the "Database" box on the main window.



Words used by text search

A word used by text search consists of letters and/or numbers only. The only exception is the apostrophe 

('), which is part of some search words (i.e. d'artagnan).

Words are stored in lower case. There are no words containing a single character only.

Extended word search is availabe in the US database for names ("lastname=miller", firstname="thomas"),

ZIP ("zip=22968"), city ("city=boston"), county ("county=orange"), state ("state=ny") and previous call 

("prevcall=a2jaq")

Every single word you can see in an entry is to be found in the word list.

Exceptions: 

- the calls displayed in the field "Call",

- the content of the fields "Longitude", "Latitude" and Locator,

- the content of the license class information fields

- the content of the extra information "Comment", "Fax number" and "E-Mail address"

- and for the US database: The fields "Country" and "DXCC", if "USA" or "United States"

are not part of the word list.



File|U.S. database command

This command sets the active database to U.S. database. 

In the U.S. database, the search options for name, city, ZIP and county are available. All information fields

are activated.

The shortcut for this command is Ctrl+U.



File|International database command

This command sets the active database to the international database. 

In the international database, the search procedures for name, city, ZIP and county are not available. 

The information fields concerning data available for the U.S. only are deactivated. However, the fields 

Call, QTH and Class in License group are never deactivated. Note that the license class information is not

available for all entries in the international database. Those entries without license class information show

an empty field.

The shortcut for this command is Ctrl+I.



Example: Search by county

Notes: 

· Use the U.S. database. (Use Ctrl+U to select.)

· Ensure that no menu is selected.

· You can also use the text search dialog to search by county.

Example: Searching for the county "orange"

Step 1: Activate the "County" edit. You can do this by clicking on the "County" edit. Pressing Alt+Y will 

lead to the same result.

The cursor is ready for your input, blinking in the "County" edit. Perhaps the text of the last search is 

displayed in call edit. Because the text is inverse, it will disappear with the first character you type in.

Step 2: Now type in the wanted county: "orange". Do not use any blanks.

Now, the county edit should show orange only.

Step 3: Finish the text input by pressing Enter.

After a short delay, the program shows the first entry containing the county "orange" (AA2DX). If the 

requested county could not be found, a window will inform you.

Note: There are many more entries with the county "orange". The "+1", "+10", etc. buttons allow to 

navigate through the entries by county, if sort by county is activated. This has been done by the program 

after the search.



Menu Report

This menu contains the commands for handling the report file:

Add entry to report file

Add search result to report file

Print labels from report file

Edit report file

Clear report file now



Example: Search by ZIP

Note: 

- Use the U.S. database. (Use Ctrl+U to select.)

- Ensure that no menu is selected.

Example: Searching for the ZIP 22968

Step 1: Activate the ZIP edit. You can do this by clicking the ZIP edit. Pressing Alt+Z will lead to the same 

result.

The cursor is ready for your input, blinking in the "ZIP" edit. Perhaps the text of the last search is 

displayed in call edit. Because the text is inverse, it will disappear with the first character you type in.

Step 2: Now type in the wanted ZIP: 22968. Do not use any blanks.

Now, the ZIP edit should show 22968 only.

Step 3: Finish the text input by pressing Enter.

After a short delay, the program shows the first entry containing the ZIP "22968" (K4EBL). If the requested

ZIP could not be found, a window will inform you.

Note: There are many more entries with the ZIP "22968". The "+1", "+10", etc. buttons allow to navigate 

through the entries by ZIP, if sort by ZIP is activated. This has been done by the program after the search.



Search|List command
Shows the list window. .

There is a shortcut for this command: Ctrl+L. ESC closes the window. 

Note: Using the list window causes longer access times.



Example: Text search

The text search is the most powerful search feature included in the callbook. Unfortunately, it is a little bit 

more complex to understand than the search by call command.

See Example 3 for a example using the new text search features!

Example1:

Note: 

· Use the U.S. database. (Use Ctrl+U to select.)

· Ensure that no menu is selected.

Imagine you want to contact another radio amateur, but the only things you can remember about him is 

his first name (Colin) and the city he lives in (Raleigh).

Using text search, you can find him out of thousands other entries:

Step 1: Choose the command Text Search in the menu Search. You can do this by opening the Search 

menu and clicking the Text search command with the mouse. Pressing Alt+S and T or    pressing F8 only 

will lead to the same result.

The "Text search" dialog appears. Click on this to see the help screen of the Text search dialog. 

The cursor is ready for your input, blinking in the "Word" edit. Perhaps the text of the last search is 

displayed in word edit. Because the text is inverse, it will disappear with the first character you type in. 

Also, if there are any words in the search list (the list on the right side), clear them by pressing Alt+C or 

click on the "Clear" button.

Step 2: Now type in the first word: colin. Do not use any blanks. Note that it is not possible to enter capital

letters.

Now, the Word edit should show colin only. In the word list, the word "colin" should be highlighted.

Step 3: Press Alt+A or click on the "Add" button to copy the word "colin" into the search list.

By now, the search list should contain the word colin only. Note that the number of entries containing the 

word "colin" is displayed after the word (156).



Step 4: Now type in the second word "raleigh" and copy it into the search list by click on the "Add" button 

or press Alt+A.

The search list should contain the two words "colin" and "raleigh".

Step 5: Click the "Ok" button or press Enter to start the search.

A window with a progress indicator appears. After a short time for searching, the program reports 

"Number of entries found: 1". Click on the "Ok" button or press Enter to close this window.

Now, the program shows the requested entry (KD4IHZ). In addition, it shows the number of the current 

entry and the number of entries found in the gap between the "+1" and "-1" button (1 of 1).

Note that in the field "Sort by" "Search results" is activated. This has been done by the program after the 

search.

Example2:

Note: 

· Use the international database. (Use Ctrl+I to select.)

· Ensure that no menu is selected.

Imagine you want to contact an radio amateur living on the Canary Islands.

Using text search, you can find him out of thousands other entries:

Step 1: Choose the command Text Search in the menu Search. You can do this by opening the Search 

menu and clicking the Text search command with the mouse. Pressing Alt+S and T or    pressing F8 only 

will lead to the same result.

The "Text search" dialog appears. Click on this to see the help screen of the Text search dialog. 

The cursor is ready for your input, blinking in the "Word" edit. Perhaps the text of the last search is 

displayed in word edit. Because the text is inverse, it will disappear with the first character you type in. 

Also, if there are any words in the search list (the list on the right side), clear them by pressing Alt+C or 

click on the "Clear" button.

Step 2: Now type in the first word: canary. Do not use any blanks. Note that it is not possible to enter 



capital letters.

Now, the Word edit should show canary only. In the word list, the word "canary" should be highlighted.

Step 3: Press Alt+A or click on the "Add" button to copy the word "canary" into the search list.

By now, the search list should contain the word canary only. Note that the number of entries containing 

the word "canary" is displayed after the word (3144).

Step 4: Now type in the second word "islands" and copy it into the search list by click on the "Add" button 

or press Alt+A.

The search list should contain the two words "canary" and "islands".

Step 5: Click the "Ok" button or press Enter to start the search.

A window with a progress indicator appears. After a short time for searching, the program reports 

"Number of entries found: 3139". Click on the "Ok" button or press Enter to close this window.

Now, the program shows the requested entry (EA1BWW). In addition, it shows the number of the current 

entry and the number of entries found in the gap between the "+1" and "-1" button (1 of 3139).

Note that in the field "Sort by" "Search results" is activated. This has been done by the program after the 

search.

Now you can use the "+1", "-1" buttons etc. to navigate through entries.

Example 3:

Note: 

· Use the U.S. database. (Use Ctrl+U to select.)

· Ensure that no menu is selected.

Imagine you want to contact another radio amateur, but the only things you know about him is his last 

name (John) and the state he lives in (Illinois, that is "IL").

With the new features in the text search facility, you can reduce the number of entries found down to just 

two. Without it, you have had to browse through 1058 entries (by using just the words "John" and "IL").



Using the new features in the text search, you can find them out of thousands other entries:

Step 1: Choose the command Text Search in the menu Search. You can do this by opening the Search 

menu and clicking the Text search command with the mouse. Pressing Alt+S and T or    pressing F8 only 

will lead to the same result.

The "Text search" dialog appears. Click on this to see the help screen of the Text search dialog. 

The cursor is ready for your input, blinking in the "Word" edit. Perhaps the text of the last search is 

displayed in word edit. Because the text is inverse, it will disappear with the first character you type in. 

Also, if there are any words in the search list (the list on the right side), clear them by pressing Alt+C or 

click on the "Clear" button.

Step 2: Now type in the first word: "state=il". Do not use any blanks. Note that it is not possible to enter 

capital letters.

Now, the Word edit should show "state=il" only. In the word list, the entry "state=il" should be highlighted.

Step 3: Press Alt+A or click on the "Add" button to copy "state=il" into the search list.

By now, the search list should contain the entry "state=il" only. Note that the number of entries is 

displayed after the entry (24554).

Step 4: Now type in "lastname=john" and copy it into the search list by click on the "Add" button or press 

Alt+A.

The search list should contain the two entries "state=il" and "lastname=john".

Step 5: Click the "Ok" button or press Enter to start the search.

A window with a progress indicator appears. After a short time for searching, the program reports 

"Number of entries found: 2". Click on the "Ok" button or press Enter to close this window.

Now, the program shows the first entry found (AA8X). In addition, it shows the number of the current entry

and the number of entrys found in the gap between the "+1" and "-1" button (1 of 2). With a click on the 

"+1" button, the program shows the second entry found (WB9CTV).

Note that in the field "Sort by" "Search results" is activated. This has been done by the program after the 



search.



Search|QSL Manager command
Opens the QSL managers list. If the current entry has a QSL manager, this information is displayed in 

the highlighted line of the managers list. The QSL managers button will be activated if the current entry 

has a QSL manager in the QSL managers list.

Use the scrollbar at the right of the QSL mangers list or the cursor keys to navigate through the list.

A doubleclick on a line will display the manager's data in the callbook window.

ESC closes the QSL managers window.



File|Print label command
This will print the current entry to a label. 

Note: The ASCII print method has to be activated to use this command.

See also: File|Send form feed, How to print



File|Send form feed command
Ejects the current page. This is especially useful for laser printers.

Note: The ASCII print method has to be activated to use this command.

See also:

File|Print label command,

Print basics



How to print labels (Print basics)
The program includes two methods for printing labels: Windows style and ASCII style.

To determine which method is activated, open the "Options" menu.The active method is indicated by a 

marker in front of the text.

To choose the printing method of your choice, use the Label printing options (General) dialog. Open this 

dialog by using the Label printing (General) command in the "Options" menu. At the page "General" on 

the dialog, choose the method of your choice click the "Ok" button.

Click here for more information about the ASCII printing method

Click here for more information about the Windows printing method



QSL managers list

The QSL managers list shows QSL managers for more than 54,000 calls. It is divided into four columns:

Call: The call of the managed station.

Manager: The call of the manager of this station. Every manager is in the callbook. A doubleclick on a line

will display the managers data in the callbook window.

Info: Additional information, e.g. about modes, operators, times of operation, etc. 

Last edited: Date of the information. Some stations have more than one manager, so "Last edited" can 

help to determine which manager would be the best to try.

Use the scrollbar at the right of the QSL mangers list or the cursor keys to navigate through the list.

A doubleclick on a line will display the manager's data in the callbook window.

ESC closes the QSL managers window.

The QSL managers list can be opened by the Search|Qsl manager command.

The QSL managers list is maintained by Manfed Meier, DF6EX. You can send corrections directly to him 

via e-mail. His e-mail address is DF6EX@winqsl.de. If you do not have access to e-mail, please send 

your correction per postage to the Radio Amateur Callbook. You will find our address printed on the case 

of your CD ROM.



The Report file
A report file is an ASCII file containing call signs line by line.

It offers the possibilty to print the labels of these call signs out of the RAC databases.

A report file can be created either manually or by the program on request. Click here for information about

how to create a report file 

Now you are able to print mailing labels for your local radio club or any other group you can think of.

The name of the report file is determined by the program settings. It can be changed in the Program 

Options Dialog. By default, it is "C:\REPORT.TXT".

 



Program options dialog

To open the dialog, use the "Program Options" command in the "Options" menu.

In this dialog, you can modify the settings for:

General: covers the settings for the clipboard and lets you specify your locator.

Report covers the settings for the report file.



Report|Add entry to report file
Adds the current entry to the report file.

See also: The report file



Report|Add search results to report file command

Adds the calls found by the last text search to the report file.

This can take a while. A progress indicator informs about the progress of the operation. Use the "Abort" 

button to stop it.

Note that nothing happens, if there were no entries found by text search.

See also: The report file



How to create a report file

Manually:

1. Use the Report|Edit report file command to open the windows editor. The editor will ask to create a 

new file if there is no report file at the moment.

2. Type in the first call on the first line. 

Type in the second call on the second line.

And so on.

3. Close the editor. Don't forget to save the file.

4. Done.

By program (current entry): 

1. Make sure that the report does not contain unwanted entries. You can clear the report file with the 

Report|Clear report file now command 

2. Search for a call until you found the requested entry.

3. Use the Report|Add entry to report file command to add the call to report file.

4. If you need more entries, go to step 2 again.

5. Done. 

By program (search results): 

1. Make sure that the report does not contain unwanted entries. You can clear the report file with the 

Report|Clear report file now command 

2. Use text search to select a group of entries (e.g. with identical ZIP code)

3. Use the Report|Add search results to report file command to add all the calls of the group to the 

report file.

4. Done.





Report|Edit report file command

Allows to edit the report file.

Note: The program calls notepad.exe to start the editor.

See the report file for information about the structure of the report file.



Report|Clear report file now command

Clears the report file. This will delete all calls in the report file.

See also: The report file



Report|Print labels from report file command

Opens the print labels from report file dialog.



Print labels from report file dialog
This is how the print labels from report file dialog looks:

Note: See Print basics before starting a printing job the first time.

This dialog controls the printing of labels from the report file. It displays the name of the report file and the 

current print status.

The "Start" button will start the printing job. Once started, the progress indicator informs about the 

percentage of printed entries. If the report file does not exist, a message "File not found" will appear.

The "Pause" button stops the current printing job. Click on the "Start" button continues the print job.

The "Stop" button aborts the current print job. Click on the "Start" button will restart the print job from the 

beginning.

As explained in Print basics some printers need an additional form feed to eject the page. The "Send form

feed" button will do this.

The "Close" button closes the dialog. During printing, the "Close" button is disabled. In this case, use the 

"Stop" button first. Note that the "Close" button is the only possibility to close this dialog.



Options|Morsecode... command

Opens the Set morsecode options dialog.



Set morsecode options dialog

Allows to set the speed and pitch of the morsecode output, by moving the scrollbars.

For testing purposes, the test text can be modified.

The "Restore defaults" button will set the following values: 60 bpm, 800 Hz and a five times "paris" test 

text.



Options|Program... command

Opens the Program options dialog.



General settings

This page of the Program options dialog allows you to determine the format information to be copied into 

the windows clipboard when using the Edit|Copy command. In addition, this is the place where you can 

specify your own locator. This locator is needed for the calculation of the beam heading and the distance 

shown in the map window. Last, this is the place to tell the program the file name where you want to store

your notes.

A locator has a certain format: It consists out of six characters, where the first and second character can 

be between "A" and "R", the third and fourth between "0" and "9" and the fifth and sixth between "A" and 

"X". The program will show an error message if the given locator is invalid.

Tip: If you do not know your locator, look up yourself in the callbook.

Notes data file:

This field can be left blank if you do not want to use the edit notes feature. If you want to use it, the file 

name designates the file in which your notes are stored. This should be a place on your hard disk, like 

"C:\notes.ndf". The file name must end with the extension ".ndf" and you need full access rights to this file.

A file name with no path in it is likely to fail, as such an file name means that this file has to be created at 

the working directory of the program which is on the CD-ROM. So it is a good idea to use an fully qualified

file name like "C:\notes.ndf".

The examples below illustrates the effects of the settings for "Format of clipboard text".

Example for "All available information:"

AA4GE
FL
34295
E
09/26/1994
09/26/2004
082.3528
026.9617
813
Sarasota
05
Heinz J Doveling, POB 578, Englewood
02/27/1927
United States
USA
(C) 1998 by Radio Amateur Callbook.
All rights reserved.



Example for "Address only:"

Heinz J Doveling, AA4GE
POB 578
Englewood, FL 34295
United States



Report file settings

This page of the Program options dialog allows two settings:

"Add call to report file" determines the way a call is added to the report file. 

"Always" will add each call you see on the screen.

"Only on user request" will add a call if the Report|Add entry to report file is used.

"Never" disables the Report|Add entry to report file command in the programs "Report" menu.

To select the name of the report file, use "Report file".

For your convenience, the buttons "Clear it now" and "Edit report file" are added. 

A click on the "Restore defaults" button restores the following values: 

- Add call to report file only on user request

- Report file: "C:\REPORT.TXT".



Label settings (ASCII)
Note: All settings on this page refer to the ASCII printing method. The Windows printing method is not 

affected by them. To change the settings of the the Windows printing method, use the "Label printing 

options (Windows)" dialog.

This page of the Label printing options (ASCII) allows three settings:

In the "Label format" group, the dimensions of your label are determined:

"Lines on label": The number of lines from the top of one label to the top of the next label.

"Char. per line": The number of characters that will fit on a single line.

"Left margin": Sets the offset of the first character of a line to the left margin of the printer.

Note that all data in the "Label format" group refer to characters used by your printer: Using a 

condensed font will increase the number of characters per line.

In the "Output to" edit field, the file or device name (i.e. LPT1, LPT2, etc.) can be entered.

Use the "CSV settings" group, to set the options for creating a CSV export file:

Check "Use it for CSV export" if you want to create a CSV export file

"Separator char" sets the character that separates the fields in the file.

The "Clear export file now" button will empty the file specified in the "Output to" edit.

The "Restore defaults" button will set the following values: Lines on label: 6, Char. per line: 35, Left 

margin: 0. Output to: PRN, Use it for CSV export: unchecked, Separator char: ";". These are the values 

for a standard printer using Avery 15/16" labels. The printer uses 6 LPI, 12 CPI, which is the factory 

setting of most printers.



Style settings

This page of the General printing options dialog determines which information is added to the address. 

You can select "Postal" country, "DXCC" country or "No country".

If "Add call to first address line" is checked, the entry's call will be added to the first line of the address 

(i.e., "John Doe, ZZ0ZZ").



Paper label settings
This page of the Label printing options (Windows) dialog covers the settings concerning the paper 

dimensions of the Windows label printing method.

In the "Paper" box, select the name of the paper and its orientation. The last entry in the list of papers 

allows you to define a customized width and height.

The "Paper margins" contains the settings for the margins of the page, ie. the unused space at the 

borders of the page.



Menu Options

This menu contains the commands for changing the programs settings:

Morsecode...

Program...

Label printing (general)...

Label printing (Windows)...

Label printing (ASCII)...

The last commands in this menu (English, Deutsch, Francais) let you choose the language of the 

program.

Either "Label printing (Windows)" or "Label printing (ASCII)" has a marker in front of the text indicating 

which print method is active. In the picture below "Label printing (ASCII)" is activated:

Use the Label printing (general)... command to choose the printing method.

The language currently active has a marker in front of its text.



The list window
In this window, entries are displayed line-by-line. Each line shows Call and QTH of an entry. You can 

browse through the entries by using the scrollbars or cursor keys (up, down, etc.). Select (highlight) an 

entry to show detailed information about this entry in the main window.

ESC closes the window. The Search|List command opens the window.

Note: Using the list window causes longer access times.



Map Window

This is how the (upper part) of the map window looks like:

The map windows displays the map for the current entry. Each time the current entry in the main window 
changes, the map view will update. A new map starts with the maximum zoom factor. In addition the beam
heading and distance to the amateur is displayed. The calculation of both beam heading and distance is 
based upon the locator shown in the main window. The precision of this values varies: For the amateurs 
inside the US, there is a location given by the FCC, so calculation is quite exact. However, for the majority
of the amateurs outside the US, there is no exact location available. In this cases, the location has been 
bound to the DXCC assignment of the amateur. This can lead to a certain amount of error for both 
heading and distance. As a rule of thumb, this effect will increase with nearer distances to your position 
and with the size of the DXCC country. Locators bound to a DXCC country are displayed in lower case .In
most cases they are shorter than six characters. An example for such a locator is "gi21", whereas a 
locator bound to an entry looks like "FN42PC".

While moving the mouse over the map, the cursor may change to a hand symbol. This means that a click 

at that position will show a more detailed map of the area the cursor points at. In the picture below the 

cursor is below the "M" of "Massachusetts".

Note: The program needs your locator for calculating the beam heading and distance. You can 
specify it in the "General" page of the "program options" dialog.



Use the "Zoom In" button to get a more detailed map. Shortcut for this command is "I". The "Zoom Out" 

button shows a larger area with less details. Shortcut for this command is "O"

"Show <Call>": Check to see the position of this amateur. Note: This feature is available only for selected

entries and maps. The position is shown by an growing circle around the position (in the picture the circle 

is located on the left side south west of Galesburg).

"Fit window": If checked, the window resizes automatically so that no scollbars are necessary to view the

entire map. Shortcut for this command is "F". Note that with a screen resolution less than 800x600 pixels, 

it is impossible to view the entire map window.

"Print" lets you print out the map currently displayed. Shortcut for this command is "P". You can abort 

printing in the setup printer dialog. A printed map is about 7 inches wide.

To close the map window, press the ESC key. To switch to the main window, use Ctrl+W.



Select the ASCII label printing method
To select the Windows label printing method, use the "Label printing options (General)" dialog.

On the "General" page, select "ASCII" as print method and click the "Ok" button.



Select the Windows label printing method
To select the Windows label printing method, use the "Label printing options (General)" dialog.

On the "General" page, select "Windows" as print method and click the "Ok" button.



How to print labels (Windows method)
Here is a list of the Windows printing method's features:

· Uses any Windows compatible printer

· Supports 2-across, 3-across, etc. label sheets

· Choose a font you like

· Customize the settings for the labels if you are using labels not included in the list of predefined labels

· Preview function

Note: Make sure that the Windows method is selected if you want to use it.

As labels are printed on a per page basis, a number of labels has to be collected before printing.

To do so, use the "Mark label for Printing" command in the "File" menu.

Finally, use the "Start printing labels" command in the "File" menu to print the labels. This will open a 

preview window. In the preview window, click on the printer symbol in the upper left corner to continue 

After the preview window has been closed, the program asks "Ok to delete the labels marked for 

printing?".

Confirm if you do not want the labels you have just printed to be stored any longer.

Deny if you want to keep them in memory for later use (e.g. to print them once again).

Note: The maximum number of labels stored in memory is 14,000.



Locator tool box
The Locator tool box allows you to do some arithmetics concerning locator, position, distance and 

heading. To start the Locator tool box, use the "Locator tool box" in the "Tools" menu. This window 

appears:

To calculate a locator, enter the longitude and latitude in the respective field in the "Locator" area. Both 
values have the format Degree°Minute'Second", followed by a indicator of the direction (N, S, W, E).
Example: 84 degrees, 5 minutes and 14 seconds of western longitude has to be entered as 84°5'14"W.

39 degrees, 44 minutes and 22 seconds of nothern latitude has to be entered as 39°44'22"N

After entering both values, click on the "Go" button or press Enter. The result is displayed at the lower part

of the "Locator" area.

To convert a locator to values of longitude and latitude, enter the locator in the respectice field in the 

"Position" area and clock on the "Go" button or press Enter. The results will be displayed at the lower part 

of the "Postion" area

To calculate the distance and heading between to points with a given locator, use the "Distance and

Heading" section of the tool box. Enter the first locator (your position) in the field Locator1 and the second

locator in the field Locator2. Click on the "Go" button or press Enter. The result will be displayed in the 

lower part of the "Distance and Heading" area. The values for a long path connection are displayed in 

paranthesis.

To view the location of a position at the world map, click on the "Map" button. The last active area to 

determines the position to display ("Locator" or "Position" area, or, in case of the "Distance and Heading" 

area, "Locator1" or "Locator2". Pressing the map button when in the "Locator" or "Position" area let the 

program calculate the result before displaying.



Hints:
· It is possible to use just a blank to replace the °, ' and " characters. This allows faster input. You can 

omit values if you do not know them: 84w will result in 84°, 0' and 0" of western longitude. For control 

purposes, the program replaces your input during a calculation by its interpretation of the value.

· It is possible to work with incomplete locators, e.g. "JO", or "EM79".

· You can copy the results of the "Locator" and "Position" areas into the clipboard. To do this, mark the 

value you are interested in and press Ctrl+Ins.

· The program uses the system settings to determine if the distance is displayed in miles or km. You 

can change these settings in the windows control panel.



Create a CSV export file
There is a way to use the ASCII label printing method for creating a CSV (comma separated value) file for

export purposes. 

To do so, follow these three steps:

1. Make sure that the ASCII label printing method is selected.

2. In the Program options dialog, enter a filename (like "C:\labels.csv") in the "Output to" edit on page 

"Labels" 

3. In the Program options dialog, "Use it for CSV export" on page "Labels" has to be checked. 

Now, erverytime you "print" a label using the "Print label" command in the "File" menu, a line with the 

content of the entry you "printed" will be appended to the file you specified in the "Output to" edit.

A typical line created by this feature looks like this:

"Nita L Lindfors, AA1DU";"POB 407139";"Fort Lauderdale, FL 33340";"USA"

Note: The character that separates the fields can be set in the "Separator char" edit on page "Labels" in 

the program options dialog.



Label printing options (Windows) dialog
To open the dialog, use the "Label printing options (Windows)" command in the "Options" menu.

In this dialog, you can modify the settings for the windows label printing method. There are three pages:

General

Paper

Layout

The buttons at the bottom of the dialog are common for all three pages:

"Load a predefined" lets you choose one of the predefined label formats that come on the CD ROM

"Load from disk" lets you reload a label format previously saved by you on your harddisk or diskette.

"Preview/Test" opens the preview window that shows the effect of the settings.

"Save" lets you save the current settings on your hard disc

"Reset" resets the report engine to its factory settings and clears all the labels to print which are currently 

in memory.

"Ok" enables the changes and closes the dialog

"Cancel" discards the changes and closes the dialog

"Help" activates the online help and shows this help topic.

Note: The settings in this dialog are in effect only if the windows label printing method is activated

See also: How to customize the label settings



General label settings (Windows)
This page of the Label printing options (Windows) dialog covers the more general settings of the Windows

label printing method.

"Name" lets you name your label settings. It is only a description that you can use.

"Printer" lets you select the name of the printer. Choose "Default" if you want to use the default printer 

defined by windows.

Use "Paper bin" to select the source of the paper. Choose "Default" to use the standard paper bin.

"Units" lets you switch between Inches and Millimeters.



Layout label settings
This page of the Label printing options (Windows) dialog covers the settings concerning the layout of the 

page used by the Windows label printing method. Layout means the position of the labels on the page 

and the used font.

"Number of columns": The number of columns on the page. For 1-across it is 1, for 2-across it is 2, etc.

"Column width": The actual width of a label.

"Column positions": Here the actual, absolute positions of the columns can be entered. These settings are

not affected by the left and right margins you may had set at the "Paper" page, they are always relative 

to the left border of the paper.

"Height of label": The actual height of the label

"Bottom offset": The amount of space between the rows of labels.

"Font" button: Lets you specify the font you want to use

"Printable area on label": Used to create a margin on each label. Useful to avoid printing "off" the label.



How to customize the label settings
Here is a description on how to customize the label settings if you do not use one of the predefined labels.

To create your own label settings, use the Label printing options (Windows) dialog and follow this steps:

1. Ensure that the Windows printing method is active.

2. Select the "General" page.

3. Name your new setting, if you like

4. Choose Printer, Paper bin and the units you want to use.

5. Select the "Paper" page.

6. Find out the paper name of the label sheet you want to use, eg. "Letter", or "A4". If you are unsure, 

measure the dimensions. You max find a paper with your dimension. If so, use it. If your 

dimensions could not be found in a predefined paper for your printer, you can use the last entry in 

the "Name" list. It should read "Custom" or something similar. Now, you can enter the dimensions 

you have measured in the "Width" and "Height" edits.

7. Choose the orientation of your paper. In most cases, "Portrait" will be correct.

8. Measure the top margin: This is the unused space from the top edge of the paper to the top edge of

the first row of labels.

9. Measure the bottom margin: This is the unused space from the bottom edge of the paper to the 

bottom edge of the last row of labels.

10. You do not need to measure the left and right margin, if the "column positions" edit on the next 

page is used (recommended). Set the left and right margin to a quarter of an inch (or 10 mm) in this

case.

11. Select the "Layout" page.

12. Enter the number of columns on your sheet in the number of columns edit.

13. Measure the width of the labels on your sheet. Enter the value in the "Column width" edit.

14. Measure the distance from the left edge of the sheet to each column on your sheet. Enter the 

values line by line in the "Column position" edit.

15. Measure the actual height of the label on your sheet. Enter this value in the "Height of label" edit.

16. Measure the vertical distance between the a label's bottom edge in one row to the top edge of a 

label in the next row. Enter this value in the "Bottom offset" edit.

17. Click on the "Font" button and select the font you want to use. The larger the choosen font, the less

lines will fit on a label.

18. The values for "Top" and "Left" in the "Printable area on label" box should read "0,0625" (Inches, or 

1,5 mm).

19. Measure the heigth and width of the area on the label where the text should appear. Enter these 



values in the "Height" and "Width" edits.

20. Try your settings with the "Preview/Test" button.

21. Correct your settings, if the result does not satisfy you.

22. Save your settings by clicking on the "Save" button.

23. Click "Ok" to use your newly created settings in the program.



Options|Label printing (General)... command
This command opens the Label printing options (General) dialog.



Select predefined label dialog
This dialog lets you choose one of the predefined labels that comes with the CD ROM.

To open the dialog, click on the "Load a predefined..." button at the Label printing options (Windows) 

dialog.

Currently, there are six different labels to choose from:

Avery 5160: 8,5"x11" sheet (Letter), 30 labels, label size 1"x2 5/8"

Avery 5261: 8,5"x11" sheet (Letter), 20 labels, label size 1"x4"

Avery 5262: 8,5"x11" sheet (Letter), 14 labels, label size 1 1/3"x4"

Zweckform 3490: 210x297 mm sheet (A4), 24 labels, label size 70x36 mm

Zweckform 4780: 210x297 mm sheet (A4), 40 labels, label size 48,5x25,4 mm

Zweckform 6023: 210x297 mm sheet (A4), 21 labels, label size 63,5x38,1 mm

Envelope #10 (Deskjet) For printing directly on an envelope #10 with printers you feed with the upper 

edge of the envelope first. An example for a printer of this type is the HP 

Deskjet. Note: Please set the paper orientation to "Portrait" before printing.

This can be done at the page "Paper" in the "Label printing options (Windows)" 

dialog.

Envelope #10 (Laserjet) For printing direcly on an envelope #10 with printers you feed with the left edge 

of the envelope first. An example for a printer of this kind is the HP Laserjet III. 

Note: Please set the paper orientation to "Landscape".



File|Mark label for printing
This command tells the program to create a label to print fro the current entry. Actual printing will be 

started with "Start printing labels" command in the "File" menu.

Notes:

The maximum number of labels stored in memory is 14,000.

The Windows printing method has to be activated to use this command.

See also: How to print labels



File|Start printing Labels
If there are already labels to print, this command will open the preview window of the label printing.

From this window, you can start to print labels by click on the printer symbol in the upper left corner of the 

window.

After the preview window has been closed, the program asks "Ok to delete the labels marked for 

printing?".

Confirm if you do not want the labels you have just printed to be stored any longer.

Deny if you want to keep them in memory for later use (e.g. to print them once again).

To choose a label to print, use the "Mark label for Printing" command in the "File" menu.

Note that the windows printing method has to be activated to use one of these commands.

See also: How to print labels



Help|Open help file as RTF command
This command tells windows to open the file "X:\texte\callbook.rtf" (where X: is path to your cd rom drive 

with the Radio Amateur Callbook inserted).

This will start a program like WordPad. From this program, you can print the entire help file or parts of it.

You need a program like WordPad or an other text processor that is able to open the file type "Rich Text 

Format" (RTF).

It is necessary to have an association with the file type ".rtf" to execute this command. Normally, this has 

been done during the installation of the text program.

If this command fails on your machine try one of the following:

· Install a program that is able to open documents in "RTF" format.

· Use the "Open the help file as text" command in the "Help" menu.

· If you have a program able to read RTF files, use it to open the file directly (file name is "X:\texte\

callbook.rtf", where "X:" is the path to the Radio Amateur Callbook CD ROM



Help|Open help file as text
This command tells windows to open the file "X:\texte\callbook.txt" (where X: is path to your cd rom drive 

with the Radio Amateur Callbook inserted).

This will start a program like the windows editor. From this program, you can print the entire help file or 

parts of it.

You can use the "Open help file as RTF" command in the menu "Help" to open it as a more formatted 

document .

Note: Instead of new page commands, the topics in text file are separated by the short text "---New 
Topic---".



The Beacon Scheduler
The beacon scheduler provides information about the beacons currently active in the NCDXF/IARU HF 

beacon system. The beacon scheduler can be activated by the "View|Beacon scheduler" command or by 

the "Ctrl+S" shortcut.

The beacon system uses 18 beacons spread all over the world operating on 5 frequencies. The beacon 

scheduler shows the transmission schedule for the next three minutes. It is very important to set the 

clock of your computer system at the correct time. The transmission of each beacon is as short as 

ten seconds, so a misleading clock will indicate an incorrect beacon as active. Every three minutes starts 

a new cycle, so setting your computer systems clock to UTC is not required.

Options in this window:
· Select a frequency by a left mouse click on one of the frequency columns at the grid.

· To show the position of a single beacon on the world map, right click on one of the beacons rows at 

the grid and choose "Show on map".

· The "Show active beacons on world map" button shows the world map with the position of the beacon

currenty active. This will continue until the beacon scheduler or the map window is closed or another 

station is shown in the map window.

· You can close the beacon scheduler by the ESC key.

More information about the NCDXF and the NCDXF/IARU international beacon system can be retrieved 

via the internet: www.ncdxf.org



Edit notes
This is how the notes window looks like:

In the notes window, you can edit your own notes for every callsign, even if an amateur is not in the 
callbook. The maximum length of the text edited is 247 characters.

To add or edit notes for an amateur, enter his call in the "Call" edit and press Enter. If there is already a
note for this callsign, the note is displayed in the note memo (like "Next schedule at friday" in the example
above). If not, no text is shown. Now edit your notes. Use the "Save" button (or the Alt+S shortcut) when 
finished.

To delete an existing note for an amateur, enter his call in the "Call" edit and press Enter. The note is 

displayed. Now click on the "Delete" button (or use the Alt+D shortcut) to delete this note. The note memo

and the "Call" edit are cleared.

Esc closes the notes window.

Notes:
· Before using the edit notes feature, a file name for the notes file has to be set. Use the "Options|

Program" command to do this

· The number of notes is limited only by the system ressources.



Menu CW
This menu contains the commands related to the morse code output.

"Morse code output" lets the program morse the text of the entry currently displayed.

"Stop output" terminates an output currently active.

There are shortcuts for these commands: F9 for "Morse code output" and Esc for stopping it.



Options|Label printing (Windows)... command
This command opens the Label printing options (Windows) dialog.



Options|Label printing (ASCII)... command
This command opens the Label printing options (ASCII) dialog.



Label printing options (ASCII) dialog
To open the dialog, use the Label printing (ASCII) command in the "Options" menu.

In this dialog, you can modify the settings for the labels used by the ASCII printing method.

All settings are concentrated on the only page "Labels" of the dialog.



Label printing options (General) dialog
To open the dialog, use the Label printing (General) command in the "Options" menu.

In this dialog, you can modify the settings for:

General lets you choose the printing method: Either "Windows" or "ASCII".

Style lets you choose what kind of information will be printed on the labels.



Menu Tools
This menu contains the commands to start useful tools:

Beacon scheduler opens the window of the same name.

The Locator tool box allows you to do some arithmetics concerning locator, position, distance and 

heading.
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